Unity Client

General Usage

Access the End-User Help Files

The Unity Client includes help files for end-users. These can be
referenced at any time in the Unity Client either by pressing the
F1 button on your keyboard, or by clicking the Help button:

The help files are opened in a separate window.

Set Your Home Page

Use the Personal Page (Continued)

The Home button takes you to your configured Home Page.

O

Home

-

To set a layout to be your Home Page, navigate to the desired
layout and select Make this layout my Home Page from the
Home button drop-down menu.

To reset your Home Page to the default, select Reset Home
Page from the Home button drop-down menu.

To add an item or layout to the Personal Page, right-click the

is unavailable, the Personal Page option may be included under
the Send To functions or, as is the case with Custom Query
results, as a special menu option to Add to Personal Page.

When adding an entire layout to your Personal Page, select
Personal Page | Add this layout to my Personal Page from the
ribbon menu.
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Personal Favorites
Page - -

| |E| Personal Page
il E+ Add this layout to my Personal Page.
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E.E Add this layout to Tile Groups.

Document Retrieval

Add Favorites

You can add the currently displayed layout to your list of
favorites by performing the following steps:

1. Click the Favorites button:

Favarites

=

2. Click Add this layout to my favorites.

The favorite can be accessed by clicking the Favorites
button again and selecting the favorite from the list.

Use the Personal Page

Many OnBase items and layouts can be added to your Personal
Page as tiles. Tiles serve as easy access points to the files,
items, and interfaces of your choice.

The Personal Page can be opened by clicking the Personal Page

ribbon button:

Personal

Page »

You can retrieve documents in the Unity Client based on the
document'’s keyword values, the text contained within the
document, or the note information contained on a document.
The following example describes how to retrieve documents
based on their keyword values.

To access Document Retrieval:

1. Inthe Documents ribbon group on the Home tab, click

Retrieval.

Retrieval

2. In the Document Retrieval pane, select a Document Type
Group.
Select a Document Type.

Note: The information contained in the panel may dynamic

change based on the Document Type Group or Document Type

you selected.

3. If desired, you can specify a date range to only return
documents that were created or imported between a
certain range of dates.

4. Alist of keyword fields displays below the date range.

Enter values for the keywords that are displayed. You can

enter as much or as little information you know.

Note: Some searches require you to enter at least one keyw

value. Search requirements are determined by your system

administrator.

5. When you have entered all search criteria, click the Find
button at the bottom of the panel.

object and select Add To Personal Page. If the right-click optipn
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Unity Client

Document Retrieval (Continued)

Document Separation (Continued)

The Search Results are displayed in a list on the right sifle
of the screen.

[, Search Results: 4 Document(s)

[

Icon Mame
[m] (=] -
Aging Report for period ending 04,30/2008

st figing Report for peried ending 03/31/2008

Aging Report for period ending 02/29/2008

e=| Aging Report for peried ending 01/31/2008

6. Double-click a document from the list to open it.

Import Documents
To import documents in the Unity Client:
1. In the Create ribbon group on the Home tab, click Import

1t

Import

The Upload layout is displayed.
2. Select the document you want to import by doing one of
the following actions:

+ Browse to the file location of the document you are
importing by clicking the Browse button,

Scan a document, or import a document image from
another supported digital storage device such as a
scanner or camera, by clicking the Acquire button,

+ If configured, select a document stored or created in
Google Drive by clicking the Drive button, or

Drag and drop the file you want to import into the white
space next to the Import pane.

3. Select a Document Type Group for the document.
Select a Document Type for the document.
4. Enter all of the necessary keyword values in each field.

5. When you are finished entering the necessary keyword
values, click the Import button to import the document into
OnBase:

'T' Import

Document Separation

Image and PDF documents can be manipulated in the
Document Separation layout. Documents and their individual
pages can undergo multiple editing processes in this layout
such as splitting, joining, rotation, and copying. Documents can
be deleted or created within Document Separation. Pages can
be dragged to different documents, or to an empty area to
create a new document.

4
Edit
Pages

To send one or more documents to Document Separation,
select Split from the Re-Index pane, the Edit Pages button in
Image tab of an open document, the Send To | Document
Separation option from the ribbon or right-click menu, or dra
and drop the document(s) into an existing Document
Separation window.

To switch between Document Display Mode and Page Display
Mode, toggle the Group by Documents button:

L

Group by
Document

Keep important pages separate while reorganizing and editing
documents by dragging them to the Page Holder.

Double-click a page to open it in Detailed View, which allows fd
full-scale viewing, rotation, and flipping.

Documents, Join Pages, or Append After Page options.

-

into Documents options.

(Rl
£

The thumbnails within Document Separation can be adjusted by
accessing the Thumbnail Settings from the ribbon menu.

Click Join to join two or more documents through the Merge

Click Split to separate a document through the Split or Break

Envelopes

Envelopes are collections of documents that you can compile
and share with other OnBase users. Any document can be put
into an envelope, regardless of content or Document Type.

Envelopes can be created and viewed by clicking the Envelopes
ribbon button on the Home tab.

(-] Envelopes

Select an envelope to view its contents.

If you would like to share an envelope with other users, select
the desired envelope and click Share Envelope.

Share
Envelope

Selected Users are the users sharing the envelope with you.

to Add to Envelope and/or Remove from Envelope, or can just
allowed to view the envelope contents. Adjust user permissions

Users can have Full Control over the envelope, can be permitted

as needed.
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Unity Client

User Options

Send Mail

System functionality and appearance can be customized in the

User Options. The User Options dialog is accessed through the

User Options button in the File Menu.

__';‘g:.'_ User Options

General Unity Client behavior and display features, Documen
display options, Document Import options, Printing options,
Retrieval Date options, and Service Mode options can be sef]
here.
Note: The Service Mode tab is only available when the
Client is running in Service Mode.
Note: Some User Options may be enforced by an administrg
designated User Option Policy.

To apply User Options:

1. Select the desired options in each tab. Selection controls
for options vary (check boxes, text fields in which you can
insert a number or date range, etc.).

2. Afteryou have selected the appropriate options, click Save
to save your changes and to close the User Options
dialog.

Unit
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Generate CSV Files

Document Search Results lists can be exported as .csv files.
CSV files can contain metadata pertinent to the documents
included. Keywords, DocPop URLs, and Document Dates are
examples of information fields that can be included in your CSV
output.

Note: CSV files cannot be generated from Full Text
result lists.

To generate a CSV file:

1. Right-click within a Document Search Results list and
select Generate CSV File. The Generate CSV File window i
displayed.

. Configure your file as desired.The document Range and
resulting Columns within the CSV file can be adjusted
here.

. In the Save to File field, enter the name and location tha
will be used to save the CSV file. You can select Browse to
navigate to the correct location.

. Click Launch Associated Application if you would like to
view the CSV file after you click Generate. The file will be
opened by your default CSV application.

. Click Generate. The CSV file has been created at the
specified location.

Or click Cancel to cancel the process and return to the

Searq

Internal mail messages can be sent to other OnBase users.
Documents and folders can be sent within the Unity Client to
other users. If you need to send documents to non-OnBase
users, external mail messages can contain documents as
attachments, or can include documents, folders, Custom Query
Results, E-Forms, and Unity Form Creation pages as Unity Pop
Links or Unity Pop Files. Recipients of Unity Pop Links and H
must be OnBase users.

Send To | Internal User
Selecting this option will allow you to send the selected or
open document or folder to another OnBase user. A new mail

message dialog is displayed and recipients, attachments,
and message body text can be edited as needed.

3

Mailbox

Received internal mail messages can be checked by clicking
the Mailbox button in the ribbon menu.

Send to | Mail Recipient

Selecting one of the two Mail Recipient options will allow you
to send the selected or open item to a user outside of
OnBase.

Note: A functional, supported email client is required to s
OnBase items externally.

Selecting Send to | Mail Recipient (as Attachment) will atta
the document(s) to a new message dialog in your configured
external email client.

Selecting Send to | Mail Recipient (as Link) opens a blank
email message containing a link to the item(s) or XML file
that references the content in OnBase, depending on your
configuration.

iles
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Document List Organization

t

search results list.

Document lists can be organized to better suit your needs. Lists
can be organized through grouping, sorting, column reordering
and stacking, and filtering through operators and drop-down
lists.

Grouping

Drag a column heading to the space above a data list to
group the list by that column.

[, Search Results: 4 Document(s)

e

Type

Ican Mame

(=] (=]
i+ AR - Aging Report (4 items)
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Document List Organization (Continued)

Document List Organization (Continued)

Sorting

Lists can be sorted by column values. Click on a column
heading to sort the list in descending order. Click the column
heading again to sort in ascending order.

Type Date I} -
(=] a (=] Y
AR - Aging Report 1/31/2008

AR - Aging Report 2/29/2008

Reordering and Stacking Columns

Click and drag a column to the area between two columns to
move it to that location:

-2
Type
N A |

AR - Aging Report

AR - Aging Report

Click and drag a column onto the header of a different
column to stack the columns:

Type Date Date -
» [s «

(m] - ] -

AR - Aging Report 1/31/2008

AR - Aging Report 2/29/2008

Filtering

The Custom Queries, Document History, Document Retrieval,
Mailbox, and Users layouts support filtering. Operators, drop-
down lists, and custom filters are available methods of list

filtering.
Click the operator button in the desired column to view
available operators:

2. Users
_—y
D
1
Equals
4 101
103

Click the drop-down list arrow to view available drop-down
list options:

2 Users
Do
D

— -

;
Note: Operator and ‘drop-down Tist options vary by column.

Select Custom from a drop-down list to open the Custom
Filter Selection dialog box. You can create your own data i

filter using conditions and operators.
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